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1. INTRODUCTION 
Read&Write 10 Gold is designed to provide 
help to computer users with reading and 
writing difficulties. It can read text aloud 
and help you construct words and 
sentences. It also has many other features, 
such as advanced spell checking, 
document scanning and Internet tools, to 
name but a few. 

2. INSTALLING READ&WRITE 
10 GOLD 
Before you can install Read&Write 10 
Gold, you must ensure that the computer 
has: 

• Internet Explorer version 7 or above 
• 512 MB RAM (Recommended: 1 GB RAM 

or greater) 
• 2 GB of free disk space 

• a Pentium 4 1.8 GHz Processor 
(Recommended: Pentium 4 2.4GHz or 
greater) 

• a sound card and speakers 
• a DVD Player (for install purpose only) 
• Windows XP SP3 or above. 

After a moment, a dialog box will prompt 
you for your serial number. Enter your 
serial number and click OK. Your serial 
number is displayed on the DVD Cover.   
The Read&Write 10 Setup Menu dialog 
box is now displayed. Click on Install Now. 
 For site license installation instructions, 
refer to the Installation and Toolkit guide. 

Follow the steps in the Microsoft Windows 
installation wizard.  

If the dialog box prompting you for your 
serial number does not appear: 
1. Browse to the location of the DVD drive 

and locate the AutoRun.exe. 
2. Double-click on it.  
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2.1 Entering your user details 
 For site license activation instructions see 

the Installation and Toolkit guide. 

When Read&Write 10 Gold starts up for 
the first time you will see the Read&Write 
User Details dialog box.  

To enter your details: 
1. Enter your serial number. 
2. Enter your name and email address. 
3. If you want to allow Texthelp to gather 

usage information to help them improve 
subsequent versions of Read&Write Gold, 
select the check box at the bottom of the 
dialog box. 

4. Click OK to finish entering your details.  

3. INTRODUCING 
READ&WRITE 10 GOLD 

You have many facilities available to you in 
Read&Write 10 Gold. The majority of them 
are covered in this user guide. If you want 
information on the following facilities, refer 
to the online help: 
• Daisy Reader 
• Pronunciation Tutor 
• Fact Mapper 
• Speech Input 
• Translator. 

 Refer to ‘Setting up the system’ in the 
online help for information on setting 
up and changing how facilities work. 

 If you want to reset your Read&Write 10 
Gold settings to the original default 

settings, click the  drop down list 
and select Reset all user settings to 
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defaults. 

3.1 Using the toolbar 
Figure 3-1 labels all of the buttons on the 
Read&Write 10 Gold toolbar. You may also 
see the following Study Skills buttons: 

•  – Highlight color button 

•  – Clear highlights button 

•  – Collect highlights button 

•  – Vocabulary tool button. 

You can: 
• position the toolbar anywhere on the 

screen by dragging and dropping it onto 
the appropriate position. If you dock the 
toolbar, you can undock it by clicking the 

 button 
• access the functions on the toolbar using 

hotkeys. You can set up your own hotkeys 

 For information on setting up hotkeys, 
refer to ‘Choosing General Options’ in 
the online help. 

• customize the toolbar 
• load your personal settings 
• view any hidden buttons that cannot fit 

on the toolbar by clicking on . 
Customizing the toolbar 
To customize the toolbar:  

1. Click the  drop down list, select 
the Current Toolbar option and then 
select the type of features you want to 
display.   

Alternatively, click the  button until 
the toolbar of your choice is displayed. A 
notification popup is displayed below the 

 button to let you know what toolbar 
you have just selected.  
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Figure 3-1 The Read&Write 10 GOLD toolbar
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The tooltip for the  button also 
indicates which toolbar is currently 
displayed.  

 For information on setting up which 
buttons you see when you select any of 
the options and to customize the toolbar 
further, refer to ‘Choosing General 
Options’ in the online help. 

2. Click the  drop down list and 
select any of the following: 

• Show tooltips on toolbar 
• Show windows behind docked toolbar. 

Loading your personal settings 
To load your personal settings, click the 

 drop down list and select Load 
my settings. 

You can save your personal settings to a 
location of your choice, e.g. a folder on 

your hard drive or on a memory stick.  

To save your personal settings, click the 

 drop down list and select Save 
my settings. 

To load your personal settings: 

1. Click the  drop down list and 
select Load my settings. 

The Browse For Folder window is 
displayed. 

2. Browse to the appropriate drive on 
your computer and then click OK to 
load your personal settings. 

4. READING TEXT 
This section explains how to use 
Read&Write 10 Gold to read text. It also 
explains how to convert text into sound 
files. 
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4.1 Reading text using the toolbar 
 You can also read text within OpenOffice 

Writer (3.0) using dual color highlighting. 

To read text using the toolbar: 

1. Click the  drop down list, and select 
Read by word, Read by sentence or 
Read by paragraph. 

2. Select the Automatically read next block 
of text from this menu if you would like to 
set up the system to automatically read 
aloud the next word, sentence or 
paragraph. To disable this facility, select 
this option again. 

3. Click one of the following buttons: 

•  – place the cursor on the word, 
sentence or paragraph, then click this 
button 

•  – to move speech back click this 
button 

•  – to move speech forward click 
this button. 

 You can use the Up (↑) and Down (↓) 
keys on your keyboard to change the 
voice speed during playback. 

The system reads the text aloud. You 
can click on either of the following 
buttons at any stage: 

•  – click this button to pause 
reading, then click on it again to 
resume 

•  – click this button to stop reading 
the text aloud. 

4.2 Reading text as you type 
To read text as you type: 

1. Click the  drop down list and select 
Speech Options. You see the Speech 
options window. 

2. Click the AUTOREAD tab and then select 
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the I would like to use speak as I type 
check box. 

3. Select any combination of the Speak on 
each letter, Speak on each word, and 
Speak on each sentence check boxes 
and then click OK. 

You can disable/enable the Speak As I 
Type facility more easily by clicking the 

 drop down list and selecting the 
Speak As I Type option. 

4.3 Activating Screen Reading  
You can instruct the system to read aloud 
information on most objects, including 
icons, toolbars and buttons, when you 
hover your mouse over them. 

To activate the Screen Reading facility: 

1. Click the  drop down list and select 
Speech Options. You see the Speech 
options window. 

2. Click the AUTOREAD tab and then select 

the I would like to use screen reading 
check box. 

3. Select the types of information you want 
the system to read by selecting the 
appropriate check boxes from the list at 
the bottom of the window and then click 
OK. 

The system will now read out information 
on the selected object types when you 
place the cursor over them or tab to 
them. 

You can disable/enable the Screen 
Reading facility more easily by clicking 

the  drop down list and selecting the 
Use Screen Reading option. 

4.4 Reading text on web pages 
To read text on a web page: 

1. Click the  drop down list and select 
Web Highlighting. 

2. Hover your mouse over an area of text 
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on a web page until it becomes 
highlighted. The system reads aloud the 
highlighted text. 

You can then use the Speech buttons on 
the Read&Write 10 Gold toolbar. 

To read text in the Firefox browser (3.0) 

select the text and click the  button. 
Click OK when prompted to install the 
plug-in. 

4.5 Using the Text Reader window 
You can use the Text Reader window to 
display text from text files, from the 
clipboard, or from Screenshot Reader. 
You can then use the Speech buttons on 
the Read&Write 10 Gold toolbar as 
required. 

 Refer to ‘Using Screenshot Reader’ on 
page 9 for more information. 

To display a text file in Text Reader: 

1. Click the  drop down list and select 
Text file from the Open in Text Reader 
menu. You see the Select file to open 
window. 

2. Browse to the location in the directory 
where the text file is located, and then 
click Open.  

To display text from the clipboard in Text 
Reader: 

1. Highlight the text in your document. 
2. Right click on the highlighted text and 

select Copy from the pop-up menu. 

3. Click the  drop down list and select 
from clipboard from the Open in Text 
Reader menu.  

4.6 Using the Speech Maker  
You use the Speech Maker facility to 
convert text in any document or program 
into speech, which can then be converted 
into a sound file. 
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To convert text to sound: 
1. Highlight the text you want to convert. 

2. Click the  button on the toolbar. 

Alternatively, click the  drop down list 
and select Speech Maker from the 
Speech Maker menu. You see the first 
window in the Speech Maker facility, 
which displays the text you selected in 
step 1. 

3. Click Next. 
4. Alter the current voice settings until you 

are happy with the settings. Click the  
button to test the new voice. 

5. Click Next. 
6. Click Save As and browse to the folder in 

the directory in which you want to save 
the sound file, then click Save, or if you 
have an MP3 player attached to your 
computer, select the MP3 drive. 

7. Select the appropriate File Format radio 
button to specify the type of sound file 

format you want to create. 
8. You can customize the MP3 settings by 

clicking on the Options buttons. 
9. Click Finish to create the new sound file. 

The next time you want to convert text 
into sound using the settings you have 
just configured: 

1. Highlight the text you want to convert into 
a sound media file. 

2. Click the  drop down list and select 
Create file using last saved settings from 
the Speech Maker menu. 

4.7 Using Screenshot Reader 
You use Screenshot Reader to read 
aloud any text on the screen. In 
particular, it can read aloud text used in 
images or any application, even if this 
text is not accessible, for example, flash. 

To use Screenshot Reader to read text: 
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1. Click the  drop down list and specify 
whether or not you want to use Text 
Reader to read aloud the text. If you do 
not select this option the text will be read 
aloud and highlighted directly on the 
screen. 

2. Click the  drop down list again and 
specify the method you want to use to 
capture screen information: 

• Capture by drawing rectangle – click and 
hold your mouse down at the corner of 
the text/image and drag and drop the 
rectangle around the text/image 

• Capture by hover – hover your mouse 
over a window and then click 

• Capture by drawing freehand – hold 
down the left button on your mouse and 
draw around the text/image. 

3. Click the  button. Your cursor now 

looks like this:  
4. Select the area of text you want to read 

aloud using the method you selected in 
step 2. 

Read&Write 10 Gold reads the text aloud 
and highlights it directly on the 
screen/Text Reader. 
 If you make sure the Automatically 
close after reading option is switched 
off in the Screenshot Reader Options 
window, you can re-read the last 
screenshot you captured. 
Importing text into MS Word 
You can also import text from a 
screenshot into either a brand new MS 
Word document, or append it to the 
document you are currently working with 
in MS Word. 

Once you have done this you can use the 
other Read&Write 10 Gold facilities on 
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the text. 

To import text into MS Word: 

1. Click the  drop down list and select 
Screenshot to MS Word. 
 To add the text to the MS Word 
document you are currently working with, 

click the  drop down list and select 
Screenshot Reading Options. Then 
select Append to active Microsoft 
Word document and click OK. 

2. Click the  button. Your cursor now 

looks like this:  
3. Select the area of text you want to 

import. 

The text is displayed in a new MS Word 
document. 

5. SPELL CHECKING 
You use the Spell Checker to spell check 
selected words, your entire document or 
as you type. 

5.1 Spell checking selected 
words 

To spell check selected words: 
1. Select the word that you want to check. 

2. Click the  button on the toolbar. If the 
selected word is: 
• correctly spelt, nothing happens 
• incorrectly spelt, you see the Spell 

Helper window (Figure 5-1). 

From the Spell Helper window, you: 
3. Select the appropriate radio button 

depending on whether you want to view 
nouns, verbs, adjectives or adverbs. To 
view all word types, select the All radio 
button. 
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Figure 5-1 The Spell Helper window
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4. Select a word from the Word list box. A list 
of alternative words and their meanings is 
displayed in the Alternative Meanings list 
box. 

5. Choose from the following options: 
• change the mis-spelt word to the selected 

word by clicking Change word  
• change the mis-spelt word throughout your 

document by clicking Change all  
• add the selected word to your custom 

dictionary by clicking Add to custom 
dictionary 

• add a mis-spelt word to the auto correct file 
by clicking Add to auto correct  

• ignore the mis-spelt word by clicking 
Ignore word. 

6. Select the Move to next error check box 
to automatically move to the next mis-spelt 
word after analyzing the current word. 

5.2 Spell checking your 
document 

To spell check your document: 

1. Click the  button on the toolbar.  

You see the Spell Helper window 
(Figure 5-1) and the first suggested mis-
spelt word in the Original Word text 
box. 

2. Follow steps 3 to 5 in the previous 
section.  

5.3 Spell checking as you type 

To spell check as you type, click the  
drop down list and select Spell As I Type. 
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6. USING WORD PREDICTION 
You can use the Word Prediction facility to 
access a list of words that will complete the 
one that you are currently typing. Word 
Prediction will also try to predict your next 
word as you finish typing a word. 

To use the Word Prediction facility: 

1. Click the  button on the toolbar. You 
see the Prediction window. This window 
displays a list of predicted words from 
which you can select. Homophones are 

marked by the  symbol. Prediction 
accuracy for each word is shown by:  

• a green indicator or circle if it is highly 
likely. This is based on probability and 
grammatically accurate based on word 
triplets 

• an orange indicator or a square if it is 
likely. This is based on probability and 
grammatically accurate based on word 
pairs 

• a black indicator or a triangle if it is least 
likely. This is based on probability only. 

2. If required, place the cursor over a 

predicted word and then click the  
button. You see the Dictionary window 
(Figure 7-1) listing definitions for the 
predicted word. 
 Refer to Section 7, ‘Using the 

Dictionary’, for information on using 
the Dictionary window. 

3. Right click on the Prediction window 
and select the prediction options. 

4. Complete one of the following 
depending on the prediction options you 
selected in step 3: 

• if you selected the Speak the word 
when clicked option, click on a word to 
hear it read aloud 



Read&Write 10 Gold Using Word Prediction 

 1 5   

• if you selected the Type the word when 
clicked option, click on a word to insert it 
into the document 

• press the appropriate function key to select 
the word that you want to insert.  

6.1 Creating your own prediction 
files 
You can set up your own prediction files 
and use them to enhance the Prediction 
facility. For example, you may have a text 
file containing text relating to biochemistry 
which contains words that are not present 
in the default Prediction file. If you add this 
text, the Prediction facility will become 
better equipped to provide you with 
predictions relating to biochemistry. 

To create your own prediction files: 
1. Highlight the text you want to use to create 

a prediction file and then copy it to the 
clipboard. 

2. Click the  drop down list and select 
Create prediction word bank from the 
clipboard. The Create a new prediction 
word bank dialog box is displayed. 

3. Enter a unique name and description for 
the new prediction file in the fields 
provided.  

The text you copied to the clipboard is 
displayed at the bottom of the dialog 
box. If required, you can edit this text 
from within this dialog box. 

4. Click OK. A message box is displayed 
explaining that the file has been saved 
in your User Setting’s folder. 

6.2 Downloading word banks 
You can download new prediction word 
banks and use them to enhance the 
Prediction facility. 

To download a word bank: 
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1. Click the  drop down list and select 
Download prediction word banks. A list of 
the prediction files currently available for 
download is displayed in the Download 
prediction word banks dialog box. 

2. If required, you can filter this list for a 
specific topic. To do this, enter the topic 
you want to search for in the Search for 
prediction word banks text box and then 
click Search. 

3. You can now select the word bank(s) you 
want to download by: 

• selecting the checkbox(es) beside the 
appropriate word bank(s) 

• clicking the Select All button to select all of 
the available word banks. 

4. Click Download. 

6.3 Previewing words in a word bank 
You can preview the words in a user-
created word bank. 

To do this: 

1. Click the  drop down list and select 
Prediction Options. The Prediction 
Options window is displayed. 

2. Select the Advanced options 
checkbox at the bottom of the window 
and then select the Context tab. 

3. Right click on the word bank in the 
Prediction word banks list box and 
select the Preview word bank option. 

7. USING THE 
DICTIONARY 

You use the dictionary to look up different 
meanings for selected words. You can 
configure the dictionary to display: 
• basic definitions – lists meanings and 

word inflections  
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• advanced definitions – allows you to 
conduct advanced dictionary functions and 
displays synonyms 

• web definitions – lists meanings in the 
Dictionary.com website. 

This chapter also helps you use the Word 
Wizard. 

7.1 Finding basic definitions 
To find basic definitions: 

1. Make sure the Basic Definitions option is 

selected in the  drop down list. 
2. Highlight the word in the text you want to 

check. 

3. Click the  button on the toolbar. You 
see the Dictionary – Basic Definitions 
window (Figure 7-1). 

The selected word is shown in the Original 
Word text box. 

4. Select the appropriate radio button to 
specify whether you want to look up 
meanings for nouns, verbs, adjectives, 
or adverbs for the word. To look up all 
word types, select the All radio button. 

You can also use the Dictionary window 
for the following functions: 

• replace the original word with a different 
word. To do this, click on one of the 
meanings displayed in the Dictionary 
Meanings list box, then click on a word 
in the Inflections list box and then click 
on Replace 

• conduct a new dictionary search. To do 
this, enter the new word in the Original 
Word text box and then click Search  

• browse through the different word 
searches you have conducted using the 
Browse buttons. When you close the 
Dictionary window, the browse history 
will clear.
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Figure 7-1 The Dictionary – Basic Definitions window 
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7.2 Finding advanced definitions 
You may need to narrow down a search if 
the word is used in many different ways.  

To do this: 
1. Make sure the Advanced Definitions option 

is selected from the  drop down list. 
2. Highlight the word in the text you want to 

check. 

3. Click the  button on the toolbar. You 
see the Dictionary – Search All Definitions 
window. The selected word is shown in the 
Original Word text box.  

 This window is similar in appearance to the 
Basic Definitions window. 

4. Click Advanced to view a list of search 
types. 

5. Click on a search type.  

The list of alternative meanings relating 
to the search item you selected is 
displayed. 

6. You can now use the other dictionary 
functions as described on page 17. The 
only difference is that you can replace 
the original word with a synonym 
instead of a word inflection. A list of 
synonyms is displayed in the 
Synonyms list box. 

7.3 Finding web definitions 
To find web definitions: 
1. Make sure the Web Definitions option is 

selected from the  drop down list. 
2. Highlight the word in the text you want 

to check. 

3. Click the  button on the toolbar. 

The Dictionary.com website is displayed. 
Your selected word and definition(s) are 
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listed. 

7.4 Using Word Wizard 
You can use the Word Wizard to: 

• help you find words or phrases that you 
cannot remember 

• search for words using opposites or other 
relationships. For example, if you search 
using the phrase 'parts of a car', the Word 
Wizard will list words like throttle, tailpipe 
and fender.  

To use the Word Wizard:  
1. Highlight the word you want to look up. 

2. Click the  button on the toolbar. 

Alternatively, click the  drop down list 
and select Word Wizard. You see the first 
window in the Word Wizard.  

3. Select the appropriate radio button to 
specify whether the word is a noun, verb, 
adjective, or adverb, and then click Next.  

 If it is obvious that the specified word is 
a certain type of word, for example, a 
noun, the first window is not displayed. 

You see the next window in the Word 
Wizard. 

4. Select the synonyms list and meaning 
that corresponds to the word you are 
searching for and then click Next.  

5. Click on one of the Advanced Search 
radio buttons depending on the type of 
search you want to conduct, for 
example, you can look for words that 
are opposite to the words in the 
specified synonym list. 

6. Click Next to continue.  
7. Click on a word or phrase in the 

Related Words or Phrases list box to 
view a list of related synonyms, i.e. click 
on a word or phrase from the list on the 
left. 
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8. Select the word you want to insert into your 
document, from the Synonyms list box. 

9. Click Replace to insert the specified word. 

7.5 Using the Verb Checker 
The Verb Checker allows you to search for 
verb conjugations. 

To use the Verb Checker: 
1. Either highlight the word you want to check 

and click the  button on the toolbar, or 

click the  button and then enter the 
word in the Verb Checker window. 

2. Click Next. The second stage in the Verb 
Checker is displayed. 

If your selected word is not a verb, the 
Verb Checker makes suggestions as to the 
word you may be looking for. In this case 
you must select a word from a list of 
suggestions and then click Next. 

3. Specify whether you want to use the 
selected word in the past, present or 
future tense by selecting the appropriate 
radio button.  

4. Click Next.  

The verb is shown in sentence format 
preceded by different personal 
pronouns, i.e. I, you (singular), he, she, 
we, you (plural) and they. Variations of 
these sentences are shown in different 
tenses.  

An example is shown in Figure 7-2. 
5. If required, you can hear a sentence 

read aloud by placing the cursor 
anywhere within the sentence and then 

clicking on the  button on the 
toolbar. 
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Figure 7-2 The Verb Checker window – step 3
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7.6 Using the Picture Dictionary 
The Picture Dictionary allows you to view 
graphical representations for words. You 
can use it on its own or alongside one of 
the other Read&Write 10 Gold facilities. 

To use the Picture Dictionary separately: 

1. Select the appropriate option from the  
drop down list depending on whether you 
want to display pictures for a selected 
word, or display pictures using a word you 
have copied onto the clipboard.  

2. Click the  button. The Picture 
Dictionary is displayed. 

3. If you want to see a Dictionary definition for 
the selected word, click on the hyperlinked 
word in the Picture Dictionary window. 

To use the Picture Dictionary directly from 
another facility, e.g. the Word Prediction 
facility: 

1. Make sure the Picture Dictionary is 
displayed. 

2. Click the  button on the toolbar. You 
see the Prediction window. This window 
displays a list of predicted words from 
which you can select. 

3. Start typing a word. A list of predicted 
words is displayed.  

4. Hover over any word in the list. A 
pictorial representation of the word is 
displayed in the Picture Dictionary 
window.  

8. USING THE 
HOMOPHONES 
FACILITY 

You use the Homophones facility to view 
descriptions of like sounding words to help 
you ensure that you have typed the correct 
word. This facility also allows you to view 
descriptions for words that you often get 
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confused, e.g. ‘thorough’ and ‘though’. 
 You can only highlight homophones and 

confusable words when using MS Word. 

To activate the Homophones facility either: 

• click the  button on the toolbar 

• click the  drop down list and select 
Show Homophones in MS Word.  

All homophones and confusable words 
within the text are highlighted. 

To deactivate the Homophones facility 
either: 

• click the  button on the toolbar 

• click the  drop down list and select 
Hide Homophones in MS Word. 

To use the Homophones facility:  

1. Click the  button on the 
toolbar. 
If the document is in MS Word, all 
homophones and confusable words 
within the document are highlighted. 
You see the Same Sounding Words 
window (Figure 8-1). 

2. Select a word from the Homophones 
list box. A list of meanings is displayed 
in the Word Meaning list box. 

3. Choose from the following options: 
• ignore the word highlighted in the text 

by clicking Ignore 
• always ignore the word highlighted in 

the text by clicking Always Ignore  
• replace the word in the text with the 

selected word by clicking Replace. 
4. Select the Move to next homophone 

check box to automatically continue to 
the next homophone after you have 
dealt with the current one. 
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Figure 8-1 The Same Sounding Words window
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 Refer to ‘Editing the Homophones facility’ 
in the online help for information on 
editing homophone groups. 

9. USING THE 
CALCULATORS 
In this section, you will learn how to use 
the Read&Write 10 Gold Standard and 
Scientific Calculators. 

9.1 Using the Standard Calculator 
You can use the Standard Calculator to 
perform calculations in much the same 
way as you would with the MS Windows 
calculator. However, the Standard 
Calculator has several added features, 
which are discussed in the following 
sections.  

To access the Standard Calculator, click 

the  drop down list and select 
Standard Calculator. The next time you 

want to access the Standard Calculator, 

you will only have to click the  button. 
The Standard Calculator is displayed. 

9.2 Changing the appearance 
of the calculators 

You alter the appearance of the 
calculators using the View menu. You 
can change the calculator 
background/foreground color by selecting 
the Background Color/Foreground Color 
option, then selecting a color from the 
color palette. 

In the Standard Calculator you can also 
use the View menu to:  
• change the size of the calculator by 

selecting Small, Medium or Large 
• change the calculator input display 

and audit trail fonts by selecting the 
Font option, then selecting the your 
font options from the Font window. 
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To revert to the default settings, click the 
View menu and select Reset Defaults. 

9.3 Selecting calculator speech 
options 
You can specify how you want 
Read&Write 10 Gold to read aloud when 
you perform calculations using the 
Standard and Scientific Calculators. 

To select calculator speech options, click 
the Speech menu and then select one of 
the following options: 

• Speak on Mouse Over – you will hear the 
name of the button read aloud when you 
hover the mouse over it 

• Confirm on Equals – you will hear the 
whole calculation read aloud after you 
click on equals 

 This option is not available on the 
Scientific Calculator. 

• Speak on Click – you will hear the 
name of the button read aloud when 
you click on it 

• Audible Button Click – you will hear 
an audible click when you click a 
button 

• No Sound on Click – you will hear no 
sound when you click a button. 

10. SCANNING 
The Read&Write 10 Gold Scanning 
facility allows you to scan documents 
directly to Microsoft Word, Internet 
Explorer or to a PDF file. It also allows 
you to acquire images from a digital 
camera. Before you perform a scan, you 
can specify the scanner settings, where 
you want to save scanned images and 
how you want them to look. 
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10.1 Configuring scanning options 
To configure scanning options, click the 

 button and select Scanning Options. 
You see the Scanner Settings window. 

You use this window to configure: 
• output settings 
• scanner settings. 

Configuring output settings 
You can specify where you want to save 
scanned images and how you want them 
to look, using output settings. To do this: 

1. Click the Output Settings tab. 
2. Specify where you want to save scanned 

images by selecting one of the following 
radio buttons: 

• Temporary file/folder – saves images to 
a temporary file/folder created by 
Read&Write 10 Gold 

• Ask for a filename every time – allows 
you to specify the filename and directory 
in which you want to save scanned 
images each time you scan a document 

• Choose a location to save to – allows 
you to specify the directory in which you 
want to save all scanned images. 

If you select this radio button, click 
Browse and browse to the location in the 
directory where you want to save your 
images. Then enter a prefix for each 
saved image in the Filename prefix text 
box. 

3. Select either of the following radio 
buttons from the PDF output settings 
section, depending on how you want your 
scanned images to look if they are 
scanned to a PDF document: 

• Fully Formatted PDF document  – will 
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contain font information 
• Image on text – will contain an image 

with embedded text. This option 
produces a more accurate representation 
of the scanned document. 

4. Select the Retain full formatting with 
graphics check box in the Word output 
settings section if you want images, 
scanned to Microsoft Word, to contain 
images and text with formatting. If you 
deselect this checkbox, the Microsoft 
Word document will contain only text. 

5. Select either of the following radio 
buttons from the HTML output settings 
section, depending on how you want your 
scanned images to look if they are 
scanned to an Internet Explorer file: 

• Retain Graphics in final output – will 
contain images and text with formatting 

• Use simple HTML, without graphics – 
will contain only text. If you select this 
option, specify if you want to use your 

own font size, style and color and 
background color by selecting the Use 
custom font and color settings check 
box. Click HTML Options to select the 
font and colors. 

6. Click OK. 

Configuring scanner settings  
You can specify how you want to scan 
documents using scanner settings. 
Before you can do this, you must be 
using TWAIN mode. Your scanner must 
also be connected to the system, as it is 
necessary to communicate with the 
scanner to accurately configure settings. 

To configure scanner settings: 
1. Click the Scanner tab (Figure 10-1). The 

options you can see depend upon the 
type of scanner you are using. 

2. Select the scanner you want to use from 
the Scanner drop down list. 
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 Figure 10-1 Scanner Settings window – Scanner tab
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3. Select the Hide your scanners 
configuration dialogs check box if you do 
not want to use your scanner’s 
configuration screens. 

4. Specify the resolution at which you want to 
scan documents by selecting either the 300 
DPI or the 600 DPI radio button from the 
Image Resolution section. 

 300 DPI is recommended for most OCR 
scanning; 600 DPI produces sharper text. 

5. Select one of the following radio buttons 
from the Multipage Settings section: 

• Single pages – allows you to scan one 
page at a time 

• Multiple pages (with prompt) – allows 
you to set up the Scanning facility to ask 
you if you want to scan more pages after 
each scan has been completed 

• Multiple pages (countdown) – allows you 
to scan multiple pages at a time. You can 
then enter the number of seconds you want 
to leave between each scan, in the 

Countdown text box 
• Multiple pages (with ADF) – allows 

you to scan multiple pages at a time 
using Automatic Document Feeder 
(ADF).  

6. Select the Enable duplex check box if 
you want to scan on both sides of the 
paper and your scanner allows you to 
do this. 

7. Specify the level of color required for 
the scanned document by selecting one 
of the Monochrome, Grayscale or Full 
color radio buttons from Color 
Settings. 

8. Move the Brightness and Contrast 
scales as required. Select the Auto 
check box if you want the system to 
adjust the brightness automatically. 
 Contrast increases the difference in 
shading between areas. 
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10.2 Scanning documents 
To scan a document: 

1. Place the document you want to scan into 
the scanner. 

2. Select the appropriate option from the  
drop down list depending on whether you 
want to scan to a Microsoft Word, Internet 
Explorer or PDF file. For example, select 
Scan to HTML if you want to scan to 
Internet Explorer. 

3. Click the  button on the toolbar.  

The document is scanned and opened in 
the application of your choice. 

You can also scan from a saved image file, 
by selecting the Scan from File option from 

the  drop down list. 

10.3 Scanning from a digital 
camera 

To scan from a digital camera: 
1. Take the required photo using your 

digital camera. 
2. Connect your camera to your computer 

using your USB cable. 

3. Click the  drop down list and select 
either of the following options: 

• Scan from WIA – select this option if 
your camera is WIA compatible. 

The MS Windows WIA Browse dialog 
box is displayed. Select the photo you 
want to scan. 

If there are two devices attached to your 
computer, for example, your camera 
and the scanner, the Select Device 
dialog box is displayed. Select your 
camera and then click OK. You can 
browse for the photo you want to scan. 
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• Scan from file – select this option if your 
camera is not WIA compatible but instead 
opens in Windows Explorer. This option 
allows you to browse for the photo you 
want to convert. 

11. USING THE FACT FOLDER 
The Fact Folder is a desk research tool, 
which allows you to capture text and 
graphics from any application and organize 
them into categories that can aid you with 
your study. 

11.1 Capturing text using the toolbar 
You can capture and save text using the 
Read&Write 10 Gold toolbar or the Fact 
Folder window. This section deals with the 
former. 

To capture and save text: 

1. Highlight the text you want to capture 

and then click the  button on the 
toolbar.  

Alternatively, copy the text to the 

clipboard, click the  drop down list 
and select the Add Clipboard Contents 
option. You see the Fact Details window 
(Figure 11-1). 

2. Complete the following fields: 
• Title – enter a name for the item 
• Date – the current date is displayed by 

default. Click the drop down list to use 
the Calendar to select a different date 

• Author – enter the name of the author 
of the item 
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Figure 11-1 Fact Details window
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• Sources – the website addresses of any 
web pages you have open are 
automatically added to the Sources list 
box. If you captured the item from a 
different source, you must add the location 
of the document to the Fact Folder. This is 
important because at some stage you may 
need to refer to the original document. 

Select the check boxes of the sources from 
which the item originated. 

To add a different source, click the  
button and locate the document in the 
Browse for a Source dialog box. 

To remove a source from the list, select the 
source and then click the  button. 

• Category – click the  button to access 
the Categories window, which allows you 
to specify to which category you would like 
to add the item 

 For more information on the Categories 

window, refer to ‘Managing categories’ on 
page 40. 
• Description – enter a statement to help 

identify the item. 
3. Click OK to save the new item to the 

Fact Folder. 

11.2 Capturing graphics using 
the toolbar 

You can capture and save graphics using 
the Read&Write 10 Gold toolbar or the Fact 
Folder window. This section deals with the 
former. 

To capture and save a graphic: 
1. Open the web page containing the 

graphic. 

2. Click the  drop down list on the 
toolbar and select Add Web Image. 

The Texthelp Web Hover popup is 
displayed at the bottom right-hand corner 
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of your screen. Hover your mouse over the 
images on the website to see them appear 
in the popup. 

3. Click on the image you want to capture. 
You see the Fact Details window (Figure 
11-1). 

4. Complete steps 2 and 3 on page 33. 

11.3 Reviewing facts 
You can review the facts you have 
collected using the Fact Folder window 
(Figure 11-2). You access the Fact Folder 

window by clicking the  drop down list 
and selecting the Review Facts option.  

You can reorder the facts by clicking on the 
column titles, and adjust the column widths 
using the double arrowed cursor. 

If you select a fact, a preview of it is shown 
in the Preview pane. If you cannot see this 
pane, click the Tools menu and select 
Preview Pane. 

11.4 Using the Fact Folder 
window 

You can use the Fact Folder window to 
review all of the facts you have collected 
and add additional facts and graphics. 

To view facts within different categories, 
click the Category drop down list and 
select the category for which you want to 
view facts. 
 You can select and deselect all facts by 
clicking the Tools menu and selecting 
either Select All Facts or Deselect All 
Facts. 
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Figure 11-2 Fact Folder window
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Displaying and editing the contents 
of facts 
If you select a fact, a preview of it is shown 
in the Preview panel. 

To display and edit the contents of a fact: 
1. Select the fact you want to view and then 

either click the  button on the toolbar or 
click the Facts menu and select Display 
Contents. Alternatively, double click on the 
fact you want to view. You see the 
Displaying Fact window, which allows you 
to view the fact contents. 

2. If required, edit the fact contents and then 
click Apply to save the changes.  
Editing fact properties 
To edit the properties of a fact: 

1. Select the fact you want to edit and then 

either click the  button on the toolbar or 
click the Facts menu and select Edit 

Information. You see the Fact Details 
window (Figure 11-1). 
2. Edit the fields as required. 

 Refer to steps 2 and 3 on page 33 for 
information on completing these fields. 

Capturing text 
To capture and save text: 
1. Highlight the text you want to capture 

and then click the  button on the 
toolbar. Alternatively, copy the text to 
the clipboard, click the Tools menu and 
select Add Clipboard Contents.  

You see the Fact Details window 
(Figure 11-1). 

2. Complete steps 2 and 3 on page 33. 
Capturing graphics 
To capture and save a graphic: 
1. Open the web page containing the 

graphic. 
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2. Click the Tools menu and select Web 
Hover. The Texthelp Web Hover popup is 
displayed at the bottom right-hand corner 
of your screen. Hover your mouse over the 
images on the website to see them appear 
in the popup. 

3. Click on the image you want to capture. 
You see the Fact Details window (Figure 
11-1).  

4. Complete steps 2 and 3 on page 33. 
Capturing files 
You can add files to the Fact Folder, for 
example, Microsoft Word documents. 

To add a file: 
1. Open Windows Explorer and locate the file 

you want to add to the Fact Folder. 
2. Click and hold down your left mouse button 

on the file and drag and drop it onto the 
Fact Folder. You see the Fact Details 
window (Figure 11-1). 

3. Complete steps 2 and 3 on page 33. 

 You can access this file from within the 

Fact Folder by clicking the  button or 
clicking on the Facts menu and 
selecting Execute. 

Capturing URLs 
To add a URL to the Fact Folder: 
1. Open your browser window and then 

open the webpage you want to add. 
2. Click and hold down your left mouse 

button on the Internet Explorer icon 
displayed beside the URL in the 
Address text box, as shown below: 

 
 

3. Drag and drop the icon onto the Fact 
Folder. You see the Fact Details 
window (Figure 11-1). 

4. Complete steps 2 and 3 on page 33. 

Internet Explorer icon
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 You can access this URL from within the 

Fact Folder by clicking the  button or 
clicking the Facts menu and selecting 
Execute option. 
Opening files and URLs in their 
native application 
If you have added a file/URL to the Fact 
Folder, you can open it in its native 
application from within the Fact Folder. 

To open a file/URL in its native application: 
1. Click the fact containing the file/URL. 

2. Click the  button or click the Facts 
menu and select Execute. You see the 
file/URL displayed in it’s native application. 
Deleting facts 
To delete a fact, you select the fact you 
want to delete, then click the Facts menu 
and select Delete. 

To delete several facts at once, select the 

check boxes beside the facts you want to 
delete and then click the Tools menu and 
select Delete Selected Facts. 
Managing categories 
You use the Categories window to manage 
categories containing facts and to specify 
to which categories you would like to add 
facts. 
 You can only do the latter function if you 
have accessed this window from the Fact 
Details window, i.e. if you are entering 
fact details. 

To access this window, click the Tools 
menu and select Manage Categories. You 
can now: 
• add a new category – click Add, enter a 

name for the category in the Edit 
Category Name dialog box and then 
click OK  
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• edit a category – select the category from 
the Category List, click Edit, enter a new 
name for the category in the Edit Category 
Name dialog box and then click OK 

• delete a category – select the category 
from the Category List and then click 
Delete 

• specify to which categories you would like 
to add facts – select the check boxes 
beside the appropriate categories.  
Exporting facts 
You can export a category of facts to an 
HTML web page or a Microsoft Word 
document. 

 For a more direct way of exporting facts to 
a Microsoft Word document, select the 

facts and then click the  button, or click 
the Tools menu and select Export All to 
Word. You will be asked to select the 
Bibliography format you want to use to 
display facts in Microsoft Word.  

To export facts: 
1. Select the category of facts you want to 

export, from the Category drop down. 
2. You can now: 
• select the check boxes of the facts you 

want to export, click the Tools menu 
and select Export Selected Facts 

• click the Tools menu and select the 
Export All option. 

You see the export window. 
3. Select the type of export you want: 
• Web Export – creates a new HTML 

web page based on the facts you have 
selected. The HTML page will list all of 
the selected facts under the same 
headings as the Fact Folder, for 
example, Name and Description 
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• Word Export – creates a new Microsoft 
Word document based on the facts you 
have selected. The document will list all of 
the selected facts under the same 
headings as the Fact Folder, for example, 
Name and Description. You will be asked 
to select the Bibliography format you want 
to use to display facts in Microsoft Word. 
Choose one of the following: 
∗ Harvard – the most commonly used 

referencing system in social sciences 
and education. It uses the author and 
the date of the work in the main body of 
the text, and then uses a reference list 
at the end of the text which contains the 
references cited in alphabetical order by 
author; this contains full details of the 
text cited 

∗ APA – developed to assist reading 
comprehension in the social and 
behavioral sciences. The date of 
publication follows the author name(s) 

and in-text references refer to items in 
the bibliography using the author 
surname and date of publication, in 
brackets 

∗ MLA – widely used in the humanities, 
especially in writing on language and 
literature. Generally simpler and more 
concise than other styles, MLA style 
features brief parenthetical citations in 
the text keyed to an alphabetical list of 
works cited that appears at the end of 
the text. 

4. Click Browse to display the Select 
Export File dialog box, specify where 
you want to save the file, enter a file 
name and then click Save. 

5. Click OK. 

Read&Write 10 Gold automatically creates 
the HTML page or Microsoft Word 
document and displays it in the appropriate 
application. 
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12. USING THE FACT FINDER 
You use the Fact Finder to search for 
information on the Internet using specific 
search engines. The search engines are 
categorized to help you select the one that 
will provide you with the best results. 

You access the Fact Finder by clicking the 

 button on the toolbar. 

12.1 Setting up the default search 
engine 
To set up the default search engine: 

1. Click the  drop down list on the toolbar 
and select Fact Finder Options. You see 
the Fact Finder Options window displayed. 

2. Click Change Default. You see a drop 
down list displaying different categories of 
search engines available. 

3. Hover the mouse over a specific 
category to display search engines 
available within the category. 

4. Click on the search engine you want to 
use as your default search engine. 

5. Click OK. 

The next time you click the  button, you 
see the Manual Text Search window, 
allowing you to search for facts using the 
default search engine. 

12.2 Searching for facts using a 
different search engine 

To search for facts using a different search 
engine: 

1. Click the  drop down list on the 
toolbar and select the Search using 
option. You see a drop down list 
displaying the different categories of 
search engines available. 
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2. Hover the mouse over a specific category 
to display search engines available within 
the category. 

3. Click on the search engine you want to use 
to search for a word or phrase. 

You see the Manual Text Search window 
displayed, allowing you to search for facts 
using the specified search engine. 

12.3 Downloading new search engines 
You can download new search engines to 
the Fact Finder from www.texthelp.com. 

To do this: 

1. Click the  drop down list on the toolbar 
and select Fact Finder Options. 

You see the Fact Finder Options window 
displayed. 

2. Click Add New Entry. 

The Download Fact Finder Sites window is 
displayed. When you click on one of the 

sites a description of it is displayed. 
3. You can now: 
• select the checkboxes beside the sites 

you want to download 
• click Select All to select all of the sites 

for download 
• search for a specific site by entering it’s 

name in the Search for fact finder 
sites field and clicking Search. If the 
site is available it will be listed. Select 
the checkbox beside it. 

4. Click Add to add the selected site(s) to 
your list of search engines. 

5. Click Close. 

12.4 Searching for facts using 
manual text entry 

To search for facts using manual text entry: 

1. Click the  drop down list and select 
Manual Text Search. You see the 
Manual Text Search window. 
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2. Enter the word or phrase you want to 
search for, in the text box provided. 

3. If required, change the default search 
engine. 

13. USING STUDY SKILLS 
You can use Study Skills to highlight text in 
Microsoft Word and in Internet Explorer 
using different colors. You can then collect 
the highlighted text and insert it into a new 
document using the: 

• Collect highlights tool 
• Vocabulary tool. 

The following sections explain how to use 
these tools. 

To use Study Skills, click the  button 
until you can see the Study Skills buttons. 
The tooltip for this button helps you identify 
the appropriate toolbar. 

Alternatively, click the  drop down 
list, select the Current Toolbar option and 
then select Study Skills. 

13.1 Using Study Skills to 
highlight text 

To use Study Skills to highlight text: 
1. Highlight text in your document/web 

page. 

2. Click any of the following  buttons: 
• Highlight yellow 
• Highlight blue 
• Highlight green 
• Highlight pink. 

Read&Write 10 Gold highlights the text in 
the selected color. 
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13.2 Collect highlights tool 
To collect highlighted text: 

1. Highlight the text you want to collect. 
 You can highlight the text in several 

different colors if you want. 

2. Click the  button. The Collect Highlights 
window is displayed. 

3. Select the color(s) of highlighted text you 
want to collect from the Choose the 
colors to collect check boxes, for 
example, select the Collect yellow and the 
Collect pink check boxes if you want to 
collect text highlighted in these colors. 

4. Select one of the following radio buttons 
depending on how you want the collected 
text displayed: 

• Order highlights by color – displays 
collected text according to the color in 
which it is highlighted 

• Order highlights by collection time – 
displays collected text according to the 
time at which it was highlighted 

• Order highlights by position in 
document – displays collected text 
according to the order in which it 
appears in the document. 

5. Specify how you want to separate one 
color selection from the other, by 
selecting the appropriate option from 
the Color collections separation drop 
down list. 

6. Specify how you want to separate each 
selection of highlighted text, by 
selecting the appropriate option from 
the Highlighted items separation drop 
down list. 

7. If required, you can specify that you 
want to collect highlighted text from 
several different documents, by 
selecting the Collect highlights from 
multiple documents checkbox. 
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8. If required, you can specify that you want 
to include a bibliography with the collected 
text, by selecting the Include bibliography 
checkbox and selecting the bibliography 
style you want to use. 

9. Click on the OK button. 

The collected text is displayed in a new 
Microsoft Word document. 

 Refer to ‘Using Study Skills’ in the online 
help for more information on Study Skills. 

13.3 Vocabulary tool 
The Vocabulary tool not only enables you 
to collect all of the words you have 
highlighted, it also allows you to add more 
words to this list and then import these into 
a new Microsoft Word document, complete 
with definitions and explanatory images. 

To use the Vocabulary tool: 
1. Highlight the words you want to include in 

your vocabulary list. 

2. Click the  button. The Vocabulary 
window is displayed. The words you 
have highlighted are shown in the 
Vocabulary list box. 

3. If you want to add a new word or 
phrase, type it into the Add new word 
to list text box and click Add.  

4. Enter a title for your vocabulary list in 
the Subject/Title text box. 

5. Specify whether or not you want to 
include images from the Picture 
Dictionary for each word in the 
Vocabulary list, by (de)selecting the 
Include images checkbox. 

6. Click OK. Your Vocabulary List is 
displayed in Microsoft Word. 

7. Save your document. 

The words are shown in a table, complete 
with dictionary meaning(s) and images. 

At this stage you can add additional notes 
for each word. 
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14. USING SCREEN MASKING  
Screen Masking allows you to ‘mask’ out 
areas of your screen and change the 
Windows system background color. This 
enables you to focus on a key area. 

To use Screen Masking, click the  
button on the toolbar.  

The defaults set up for this facility mean 

that when you click the  button, the 
Windows system background color 
changes, with no masking. You can 
change this functionality to suit your needs. 

To change Screen Masking options: 

1. Click the  drop down list and select 
Screen Masking Options. 

The Screen Masking Options window is 
displayed. 

2. Select the type of masking you want to 
use from the Select Masking Type 
drop down list, e.g. if you select Tint 
everything except the window I'm typing 
in, the main area of focus is highlighted. 

3. Click the Spotlight tab to enable or 
disable the spotlight functionality. If the 
spotlight option is enabled, the focal 
point moves as you move your mouse 
around, and settles on the main area of 
focus when you start to type. 

4. Click OK to save your settings. 

15. APPENDIX 
15.1 Accessing PDFaloud from 

the Read&Write 10 Gold 
toolbar 

You can access PDFaloud by clicking the 

 button on the Read&Write 10 Gold 
toolbar. A Browse dialog box is displayed, 
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which allows you to locate and open a PDF 
file. Once the Adobe window opens, the 
PDFaloud toolbar is made available for 
use. 

15.2 The PDFaloud toolbar 
The PDFaloud toolbar is added onto your 
Adobe Acrobat/Reader toolbar. This simple 
toolbar has various buttons to activate 
speech within the PDF document.  

 

 – Select to have one word spoken at a 
time or an area of selected text. You can 
choose to have text spoken by word, 
sentence or paragraph. 

 – The click and Speak tool when 
pressed allows you to point and click on 
the text which is to be spoken. 

Text will be read back with dual color 

highlighting. 

 – Speak the selection. 

 – Read the previous selection. 

 – Pause the speech. 

 – Read the next selection. 

 – Stop the speech. 

All key features have keyboard shortcuts. 
The Options button provides access to the 
program settings: 
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The voice pitch, speed and volume can be 
varied and a variety of male and female 
voices are available: 

 

From time to time the voice may mis-
pronounce a word. This is easily fixed by 
opening the Pronunciation Options menu 
and typing words into the box, as illustrated 
in the following diagram. To ensure proper 
pronunciation, simply type the word 
phonetically into the second text box and 
save the changes. 

 
 To access the PDF Aloud toolbar from 
Adobe Reader 10, click Tools at the top 
of the PDF document. A panel is 
displayed on the right-hand side of the 
window. Click Plug-in: PDF Aloud. 
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